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Copyright 

Copyright © 2015 Colorado Department of Transportation. All Right Reserved 

Many of the designations used by manufacturers and sellers to distinguish their products are claimed 
as trademarks. MicroStation and InRoads are trademarks of Bentley Systems Incorporated. Where 
other designations appear in this book, and the authors were aware of a trademark claim, the 
designations have been capitalized. 

The Colorado Department of Transportation (CDOT) has accepted this document. By accepting this 
document, CDOT assumes ownership and all responsibilities associated with this document. This 
information is subject to change without notice. 

Disclaimer 

Notice of Disclaimer: CDOT provides documents on an “as is” basis. All warranties and 
representations of any kind with regard to said documents are disclaimed, including the implied 
warranties of merchantability and fitness for a particular use. Under no circumstances will CDOT or 
any of its officers or employees be liable for any consequential, incidental, special or exemplary 
damages even if apprised of the likelihood of such damages occurring. CDOT does not warrant the 
documents against deficiencies of any kind. The use of any of these documents for work which is 
under contract with CDOT does not relieve the contractor from any obligation assumed by the 
contract, or from complete and proper fulfillment of the terms of the contract, nor does it entitle the 
contractor to compensation for damages or loss which could be attributed to such use. 

Notice 

This manual may be freely copied or distributed for the purpose of providing the Colorado Department 
of Transportation and Colorado customers a consistent guide to using the Bentley suite of products to 
meet CDOT’s design and drafting standards. 

Software Versions 

The software products referred to in this publication are furnished under a license and may only be 
used in accordance with the terms of such license. This document intended for use with the following 
software versions: 

 MicroStation® version 08.11.09.714 ProjectWise Explorer® version 08.11.11.590 
 InRoads® version 08.11.09.845 CDOT Configuration version 06.00.00 

  



 

 

 



MicroStation for CDOT Users  

 

 i 

TABLE OF CONTENTS 

MICROSTATION (SS4) UPGRADE GUIDE .......................................................................... 1 

User Configuration File ................................................................................................... 1 

MicroStation Interface .................................................................................................... 2 

Mouse Button Assignments ............................................................................................ 3 

CDOT Menu ................................................................................................................... 4 

Status Bar Enhancements .............................................................................................. 5 

Dock and Hide Dialog Boxes .......................................................................................... 6 

Measure Tools ............................................................................................................... 7 

Measure Distance ................................................................................................. 7 

Modify Tools ................................................................................................................... 8 

Break Element Tool ............................................................................................... 8 

Manipulate Tools .......................................................................................................... 10 

Copy Parallel ....................................................................................................... 10 

Trim to Element ..................................................................................................... 9 

Referencing Shapefiles ................................................................................................ 11 

Place Note.................................................................................................................... 12 

Project Explorer ............................................................................................................ 13 

Assigning a Geographic Coordinate System (GCS) to Design File ............................... 17 

Future Workflows ......................................................................................................... 19 

Bentley Descartes ............................................................................................... 19 

Point Cloud Capabilities ...................................................................................... 19 





MicroStation for CDOT Users  

 

 i 

 

MicroStation (SS4) Upgrade Guide 
This guide has been created for existing MicroStation users at CDOT. It is not 

intended to be used as a beginning training manual. The manual has been 

developed to help CDOT users that are familiar with MicroStation V8i SS2 migrate to 

MicroStation V8i SS4. Even though there are few changes between SS2 and SS4, 

the goal of this manual is to give the user an introduction to some new interface 

items along with a review of some new CDOT MicroStation workflows. 

 

MicroStation V8i (SELECTseries 4) CDOT Configuration 

User Configuration File 

After your computer, has been upgraded with the new SS4 configuration, you will 

need to create a new user configuration file (UCF) file. This file only needs to be 

created one time on the user’s computer. Follow these steps to create the UCF file: 

1. Using Windows Explorer, navigate to C:\Workspace\Workspace-

CDOT_SS4\Standards\exes. 

2. Double click on the file called manage_ucf.bat. This will quickly run a 

batch file creating the users UCF file. 
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MicroStation Interface 

You will not see any major changes to the CDOT default interface. 

There is however a new task bar that has been added enabling the user to access 

many more commands than the Drawing task bar. This task bar is called Main 

Classic. 
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Mouse Button Assignments 

It has been common practice to change the default mouse button settings for 

Tentative from using the Left Button - Right Button Cord to the Middle button. This 

makes it easier to tentatively snap to existing data.  

Another setting that is recommended, is to set the XButton1 to Left Button - Right 

Button Cord (pressing the left and right mouse buttons at the same time). This 

enables the user to activate the pan view by clicking the Left Button and Right 

Button at the same time. 

1. From the Workspace pulldown, select Button Assignments. 

2. Click on the Remap Buttons button. 

 

3. Highlight XButton1. 

4. Move the cursor into the Button Definition Area and click the left button 

and right button of the mouse at the same time. 

 

5. Review the button assignments to ensure that they match the above 

image. 

6. Left Click the OK button to finish, 

7. In the Button Assignments dialog box, click OK to save the settings. 
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CDOT Menu 

The CDOT menu no longer starts up automatically when MicroStation starts. This 

was changed to allow the Print Organizer to run smoother. The CDOT Menu can still 

be started from the Colorado DOT custom task bar. 

 

After the CDOT Menu has been started, select the CDOT group or groups that you 

wish to use. This can be done by clicking on the CDOT Groups pulldown in the 

CDOT Menu. 

Select All to open all the CDOT Groups. 
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Status Bar Enhancements 

You can modify what is seen in the status bar located at the bottom of the 

MicroStation interface. 

1. Move the cursor onto the status bar and right-click. 

 

There are some new options such as Running Coordinates and Task. 
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Dock and Hide Dialog Boxes 

Docked dialog boxes can now be grouped together in some cases using the new Pin 

Group, and Unpin Group icons. 

For example, the References, Level Display, and Raster Manager can be grouped 

together at the top of the screen. 

 

1. This can be achieved by opening a dockable dialog box like references. 

2. Drag the dialog box over one of the docking indicators that will appear in 

the center of the screen or along the edge of the interface window. 

 

3. As soon as you begin to drag the dialog box, a transparent block 

representing the dialog box will follow your cursor. Move the cursor until it 

releases to its new position. 

4. Release the mouse button. 

5. Once the dialog box repositions itself, click on the Pin (pushpin) icon in the 

upper-right of the box. 

 

6. The reference dialog will now show up as a tab in the interface window. To 

temporarily display the docked dialog box, move the cursor over the tab to 

expand the dialog box. 
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Measure Tools 

Measure Distance 

The measure distance tool now includes Start Point, End Point, and Delta for the 

distance specified. 

The Measure Distance tool can be accessed from the task bar by placing the 

cursor over the Measure tool icon and selecting the Measure Distance command. 

 

Once the command has been activated, be sure to read the steps located in the 

bottom left hand corner of MicroStation. 

1. The first prompt reads Measure Distance Between Points > Enter start 

point. Left Click on the desired location. 

2. Select a second point to define the length to be measured. 

3. To see the new measurement outputs, click on the little triangle in the 

lower right corner for the Measure Distance box. 
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This will open up the dialog box to reveal the new X,Y,and Z information. 

 

 

Modify Tools 

Break Element Tool 

MicroStation SS4 has additional tool setting options available for the Break 

Element tool. 
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These include: 

 Break by 2 Points 

 Break by Point 

 Break by DragLine 

 Break by Elements 

 

Trim to Element 

This tool replaces the Extend Element to Intersection command and will take 

some practice getting used to. This new tool will now work on shapes, complex 

shapes, solids and multi-lines. 

You must use the CTRL key to select additional elements to modify. 
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You can also drag a line to select multiple elements when the command asks 

you to identify elements to modify. 

 

Manipulate Tools 

Copy Parallel 

The old copy parallel command has had a couple of additional options added. 

 Copy Parallel a Segment of Element 
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 Copy Parallel a Portion of Element 

 

 

Referencing Shapefiles 

MicroStation allows you to reference Shapefiles. When requesting GIS information, 

you may receive a hand full of files which support the shape file. These files all need 

to be located in the same folder location. When MicroStation reads the information 

from the SHP file, it will also read the information from these support files.  

Once the shapefile has been referenced, you can use the Element Information tool 

to see the attribute information.  
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Place Note 

This is not new in SS4 but it is something that has come up many times during 

training and support calls. The default setting in the Place Note command is to start 

the terminator when the command starts. You can change this setting by setting the 

Start At: to Text. This allows you to place the Text first and then the arrowhead. 
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Project Explorer 

Project Explorer is a utility that allows the user to organize project data within 

MicroStation using links to documents and other tools. When using InRoads SS4, 

this utility will be used during project design. CDOT is currently exploring additional 

options to efficiently use this utility. 

Project Explorer can be started by using the File pulldown and selecting Project 

Explorer. 

 

The links section within Project Explorer enables the user to link supporting 

information to data within MicroStation such as photos and URL links to websites. 

For example, a link could be created showing a photo of a culvert and a link to a 

website with information on the culvert information. 

Linking a photo to a cell can be done by using the following steps. Begin by creating 

a new Link Set. 

1. From within MicroStation, select the pulldown File > Project Explorer. 

This will start up the Project Explorer dialog box. 
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2. Click on the magnifying glass icon. This will open up the Link Sets dialog 

box. 

 

3. From the drop down list select Active File. 

4. Click the New button in the Link Set dialog. 

 

5. Type a New Link Set name and then click OK to create the link set. 

 

6. Dismiss the Link Sets dialog box. 
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7. Back in the Project Explorer dialog box, select the new link set and then 

click on the Create Link icon. 

8. Click Link from File… 

 

9. Navigate to the photo you wish to link to a MicroStation element. 

10. Select the photo and click Open. This will bring up the Link Target dialog 

box. 

11. Highlight the Link Target file name then Click Ok to close the Link Target 

dialog box. 
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12. In the Project Explorer dialog box, right click on the photo file and select 

Add Link to Element. 

 

13. Left click on the desired element. This will leave a small photo icon on the 

element. 

  

14. To verify the image has been attached, click on the Element Selection 

tool. 

 

15.  Then double click on the photo icon. This will bring up the photo in a 

viewer. 

This process can be used to link other document types, such as PDF, Word, 

and Excel. 
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Assigning a Geographic Coordinate System (GCS) 
to Design File 

The key to having design files and imagery properly line up with one another is in the 

GCS assignments. When referencing imagery, it is important to know the GCS of the 

file. Without knowing the GCS, there is no guarantee the imagery will line up with the 

project data. 

Note: A detailed workflow with instructions intended to be used by the 

specialty groups to assign the project Geographic Coordinate System 

(GCS), created by Survey can be accessed from the CDOT website by 

using the following link. 

Workflow MS-24 – Assigning A Project Geographic Coordinate System 

(GCS). 

The Geographic Coordinate System dialog box provides the tools for assigning a 

GCS to the design file. Use these tools to assign a GCS from a list of systems from 

a library or from another design file which already has a system assigned. 

 

The Geographic Coordinate System tools can be accessed by using the 

MicroStation Tools > Geographic > Select Geographic Coordinate System 

pulldowns. 

Note: it is recommended that an individual 2D design file be created for each 

set of images. 

  

https://www.codot.gov/business/designsupport/cadd/cadd-workflows/v8i-ss2/ms-24/view
https://www.codot.gov/business/designsupport/cadd/cadd-workflows/v8i-ss2/ms-24/view
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Using the From Library command allows you to select a GCS system from a library 

of know systems and a list of common systems used in Colorado. 

 Expanding the Favorites folder will reveal a Colorado favorites list. 

 

 Click OK after selecting the correct system. 

 It is possible a message dialog box will appear with a warning message. 

 

 The storage units of the design file should not be changed. Click OK to 

continue. 

 This will assign the selected GCS to the design file. 

Using the From Library command allows you to select a GCS system from a file 

that has been assigned with a project coordinate system.  

 From the Geographic Coordinate System dialog box select From File 

this allows you to select a coordinate system that has already been 

assigned. A good example would be to select the Survey Topo file where 

the surveyor would have assigned the project coordinate system. 
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Future Workflows 

CDOT is currently developing workflows for some additional tools and add-ins to the 

SS4 software. 

Bentley Descartes 

Bentley Descartes adds tools for image editing, enhancement and 

georeferencing to MicroStation. A major benefit of Descarts will be the ability to 

take existing large size images and clip out new smaller images to be used on 

CDOT projects. 

Point Cloud Capabilities 

Having point cloud data available during the design phase has become 

increasingly helpful. MicroStation SS4 enables design teams to leverage point 

cloud data. The capabilities within MicroStation allow for viewing and measuring 

without the need for additional software. 
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